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Lab Overview 

Introduction 

Note: This lab is the sixth in a series of seven labs, which explore self-service BI with Excel 2013 

and Office 365 Power BI. If you plan to complete all of the labs, we recommend that you 

complete them in the order in which they were designed, although the labs can be completed 

in any order you choose. 

 

This lab was produced by using the Microsoft Power Map Preview for Excel version 2013 

published 27 May, 2014. 

In this lab, you will use Power Map to produce a tour consisting of four scenes to spatially and 

temporally present revenue data for the Tailspin Toys sales operations. You will then embed a 

video of the tour into a PowerPoint presentation. 

 

Objectives 

The objectives of this exercise are to: 

 Introduce working with Power Map 

 Preparing a Power Pivot data model for Power Map 

 Create a tour consisting of four scenes 

 Play and view a tour 

 Produce a video of the tour 

 Embed the video into a PowerPoint presentation 

 

Exercises 

This hands-on lab comprises the following exercise: 

1. Exploring Power Map 

 

Estimated time to complete this lab: 30 minutes 

  

http://www.microsoft.com/en-us/download/details.aspx?id=38395
http://www.microsoft.com/en-us/download/details.aspx?id=38395
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Exercise 1: Exploring Power Map 

In this exercise, you will create a Power Map tour consisting of four scenes. 

 

Task 1 – Opening and Exploring the Excel Workbook 

In this task, you will open an existing Excel workbook (completed in Lab 05). 

1. To open Excel, on the taskbar, click the Excel program shortcut. 

2. In Excel, click Open Other Workbooks (located at the bottom of the left panel). 

 

Figure 1 

Identifying the Open Other Workbooks Command 

 

3. Select Computer, and then click Browse. 

4. In the Open window, navigate to the D:\PowerBI\Lab06\Starter folder. 

5. Select the Sales Analysis.xlsx file, and then click Open. 

Note: This is the workbook completed in Lab 05. 

 

6. If prompted with a security warning, click Enable Content. 

 

Figure 2 

Enabling the Workbook Content 

 

7. On the File ribbon tab (also known as the backstage view), select Save As, select 

Computer, and then click Browse. 

8. In the Save As window, navigate to the D:\PowerBI\Lab06 folder. 

9. Click Save. 
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Task 2 – Enabling the Power Pivot Add-in 

In this task, if necessary, you will enable the Power Pivot Add-in. In Excel 2013, by default, the 

Power Pivot Add-in is disabled. 

1. On the File ribbon tab, select Options. 

Note: If the PowerPivot ribbon tab is available, there is no need to complete the steps 

in this task; continue the lab from Task 3. 

 

 

Figure 3 

Locating the Options Option 

 

2. In the Excel Options window, select the Add-Ins page. 

 

Figure 4 

Locating the Add-Ins Page 

 

3. In the Manage dropdown list, select COM Add-Ins, and then click Go. 

4. In the COM Add-Ins window, select the Microsoft Office PowerPivot for Excel 2013 

add-in, and then click OK. 

5. Notice the addition of the PowerPivot ribbon tab. 
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Task 3 – Modifying the Power Pivot Data Model 

In this task, you will modify the Power Pivot Data Model to unhide columns. Columns were 

intentionally hidden to prepare the data model for business user querying. However, Power Map 

does not surface hierarchies, so the columns used as hierarchy levels will need to be unhidden. 

Also, the Date column from the Date table was also hidden, and will need to be unhidden to 

allow time animations. 

1. On the PowerPivot ribbon tab, click Manage. 

 

Figure 3 

Launching the Power Pivot Window 

 

2. If necessary, maximize the Power Pivot window. 

3. Select the Product table. 

 

Figure 4 

Selecting the Product Table 

 

4. Right-click the Product column header, and then select Unhide From Client Tools. 

5. Repeat the last step to unhide the Category column also. 

6. Select the Date table, and then unhide the Date, Day, Month, Quarter and Year 

columns. 

Tip: It is possible to multi-select contiguous columns, and then right-click the selection 

to unhide several columns at the same time. 
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Task 4 – Creating a Power Map Tour 

In this task, you will create a tour. A tour is a collection of related scenes – with each scene 

representing a spatial visualization of data. You will create four related scenes. 

1. Switch to Excel. 

2. If prompted to apply the data model changes in Power View, click OK. 

3. On the Insert ribbon tab, inside the Power Map group, click the arrow, and then select 

Launch Power Map. 

 

Figure 5 

Launching Power Map 

 

4. In the Power Map window, if necessary, maximize the window. 

5. In the Tour Editor pane (located at the left), notice the first, and default, scene of the 

tour. 

6. Click Tour 1, replace the text with US Sales, and then press Enter. 

 

Figure 6 

Locating the Tour Name 

 

 

  



 

 

 

Page 10 

© Copyright 2014 Microsoft Corporation. All rights reserved. 

Task 5 – Configuring the First Scene 

In this task, you will configure the first (default) scene to display revenue by product category for 

the northeast region of the United States. 

1. To configure the first scene, hover over the scene until the configuration icon appears. 

 

Figure 7 

Locating the Scene Configuration Icon 

 

2. Click the configuration icon. 

3. In the Task Panel pane (located at the right), in the Scene Name box, enter Northeast 

Sales. 

4. On the Home ribbon tab, from inside the Map group, click Themes and select the 

second theme on the first row. 

 

Figure 8 

Locating the Second Theme 

 

5. On the Home ribbon tab, from inside the Map group, click Map Labels. 
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6. To define the first layer for the scene, in the Task Panel pane, click the Field List icon. 

 

Figure 9 

Locating the Field List Icon 

 

7. In the field list, notice that the fields are grouped by table name, and that the tables are 

sorted alphabetically by name. 

8. In the State table, check the State field. 

9. In the Geography and Map Level pane (located beneath the field list), notice that the 

State field has been added. 

10. If necessary, in the corresponding dropdown list, select State/Province. 

Note: The data model column data category configured in Lab 04 is set to State or 

Province, and so this dropdown list should default to that setting, but sometimes 

doesn’t. 

 

11. Notice also that the map view zooms out to display all data points at the spatial 

midpoint of each state. 

12. To configure the layer data visualization, click Next (located at the bottom of the pane). 

13. To analyze revenue, in the fields list, in the Sales table, check the Revenue field. 

14. In the map, notice that the state revenue values are displayed by bars, and that a legend 

is added to the scene. 

15. To categorize the revenue, in the field list, in the Product table, check the Category field. 

16. In the map, notice that the bars are converted to stacked bars. 

17. To change the chart type to a clustered column chart, in the layout area, select the 

Clustered option. 

 

Figure 10 

Locating the Clustered Option 
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18. On the Home ribbon tab, from inside the Layer group, click Shapes and then select the 

Triangle. 

19. To show the map of northeast USA, on the Home ribbon tab, from inside the Map 

group, click Find Location. 

20. In the Find Location window, enter Maine, and then click Find. 

Tip: The find location feature can be used to find any type of geographic location, 

including countries, cities, states, addresses and even landmarks. 

 

21. To close the Find Location window, click X. 

22. Use the pan and zoom controls to fill scene with the entire northeast region of the 

United States, and to see the clustered columns in perspective. 

 

Figure 11 

Locating the Pan and Zoom Controls 

 

 

Figure 12 

Reviewing the Scene Display 
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23. Resize the legend to a smaller width and relocate to an area of the scene that does not 

conceal the data on the map. 

24. To configure the first layer for the scene, in the Task Panel pane, click the Layers icon. 

 

Figure 13 

Locating the Layers Icon 

 

25. To configure the first (default) layer, click the Layer 1 configuration icon. 

 

Figure 14 

Locating the Layer Configuration Icon 

 

26. To edit the layer name, hover Layer 1 to reveal the Layer Name box, and then click the 

edit button located at the left of the box. 

 

Figure 15 

Locating the Edit Button 

 

27. Replace the text with Product Category, and then press Enter. 

28. Notice that the legend title updates to display the layer name. 

29. In the map, hover the cursor over various columns to reveal tooltip information. 
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Task 6 – Creating a Second Scene 

In this task, you will create new scene to display revenue by product category for the west coast 

region of the United States. This scene will include a text box to relay textual information. 

1. To create a second scene, on the Home ribbon tab, from inside the Tour group, click 

Add Scene. 

Note: A new scene is as a clone of the scene that was in focus when the scene was 

created. 

 

2. To edit the scene, in the Task Panel pane (located at the right), click Scene Options. 

 

Figure 16 

Locating the Scene Options 

 

3. In the Scene Name box, enter West Coast Sales. 

4. In the Effect dropdown list, select FlyOver. 

Note: Effects provide camera-like effects. 
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5. Use the pan and zoom controls (or use the Find Location feature or mouse drag 

operations) to reposition the map over the west coast region of the United States. 

 

Figure 17 

Reviewing the Scene Display 

 

6. Relocate the legend to an area of the scene that does not conceal the data on the map. 

7. On the Home ribbon tab, from inside the Insert group, click Textbox. 

8. In the Add Text Box window, in the Title box, enter West Coast Sales. 

9. In the Description box, enter Exceeding all expectations!, and then click Create. 

10. Resize and relocate the textbox to an area of the scene that does not conceal the data on 

the map. 

 

Task 7 – Creating a Third Scene 

In this task, you will create another new scene to display revenue by demographic for the entire 

United States. 

1. To create a third scene, on the Home ribbon tab, from inside the Tour group, click Add 

Scene. 

2. In the Task Panel pane, in the Scene Name box, enter Revenue Growth by 

Demographic. 

3. In the Task Panel pane, click the Layers icon. 

 

Figure 18 

Locating the Layers Icon 
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4. To delete the Product Category layer, click the X icon. 

5. When prompted to confirm the deletion, click Delete. 

6. To remove the West Coast Sales textbox, right-click any part of the textbox, and then 

select Remove. 

7. Pan and zoom to show the entire United States. 

8. In the Task Panel pane, click the Add Layer icon. 

 

Figure 19 

Locating the Add Layer Icon 

 

9. In the field list, in the State table, check the State field. 

10. If necessary, in the corresponding dropdown list, select State/Province, and then click 

Next. 

11. In the field list, in the Sales table, check the Revenue field. 

12. In the field list, in the Product table, check the Demographic field. 

13. In the layout area, select the Bubble visualization. 

 

Figure 20 

Locating the Bubble Visualization 

 

14. In the field list, in the Date table, check the Date field. 

Note: Date fields (of data type date) can be used to animate a scene across time. 
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15. In the field list, to the right of the Time box, click the clock symbol, and then select Data 

Stays Until it is Replaced. 

 

Figure 21 

Locating the Time Calculation Mode Icon 

 

16. Verify that the layer layout is configured as follows. 

 

Figure 22 

Reviewing the Layer Layout 

 

17. In the map, right-click the date and time textbox (located at the top left corner), and then 

select Edit. 

18. In the Edit Time Decorator window, in the Time Format dropdown list, select June 

2010. 

19. Click Accept. 

20. In the Task Panel pane, click the Layers icon. 

21. To the right of the Layer 1 layer, click the configuration (cog) icon. 

22. In the Layer Name box, replace the text with Demographic. 

23. Resize the legend. 

24. In the Formatting section of properties, enhance the bubble characteristics by modifying 

the Size and Thickness to levels that suit. 
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Task 8 – Creating a Fourth Scene 

In this task, you will create a final scene to display revenue by demographic for the state of 

California. This scene will also include an annotation to relay textual information based on field 

data. 

1. To create a fourth scene, on the Home ribbon tab, from inside the Tour group, click Add 

Scene. 

2. In the Task Panel pane, select Scene Options. 

3. In the Scene Name box, enter CA Revenue Growth by Demographic. 

4. In the Effect dropdown list, select Push In. 

5. Pan and zoom to show the entire state of California. 

 

Figure 23 

Reviewing the Scene Display 

 

6. Select the largest segment of the bubble (representing about 60% of revenue for the 

Advanced demographic). Ensure that the segment is highlighted. 

7. Right-click the selected segment, and then select Add Annotation. 

8. In the Add Annotation window, above the Title box, select the second option, and then 

in the adjacent dropdown list, select Demographic. 
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9. Above the Description box, select the Fields option, and then, in this order, check the 

Date and Revenue fields. 

 

Figure 24 

Reviewing the Annotation Configuration 

 

10. Click OK. 

 

Task 9 – Playing the Power Map Tour 

In this task, you will play the tour. 

1. To play the tour, on the Home ribbon tab, from inside the Tour group, click Play Tour. 

2. When the tour has completed, click the arrow located at the bottom left corner of the 

screen, or press Escape. 
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Task 10 – Creating a Video 

In this task, you will create a video of the tour. 

1. To create a video of the tour, on the Home ribbon tab, from inside the Tour group, click 

Create Video. 

2. In the Create Video window, select the Quick Export & Mobile option. 

Note: Higher video quality requires a longer time to render. 

 

 

Figure 25 

Reviewing the Video Quality Configuration 

 

3. Click Create. 

4. In the Save Movie window, navigate to the D:\PowerBI\Lab06 folder. 

Note: The file name defaults to the tour name. 

 

5. Click Save. 

6. When the video rendering has completed, click Close. 
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Task 11 – Embedding the Video into a PowerPoint Presentation 

In this task, you will embed the video into a PowerPoint presentation. 

1. To open PowerPoint, on the taskbar, click the PowerPoint program shortcut. 

2. In PowerPoint, click Open Other Presentations (located at the bottom of the left panel). 

 

Figure 26 

Locating the Open Other Presentations Command 

 

3. Select Computer, and then click Browse. 

4. In the Open window, navigate to the D:\PowerBI\Lab06\Assets folder. 

5. Select the US Sales Review.pptx file, and then click Open. 

6. On the File ribbon tab, select Save As | Computer, and then click Browse. 

7. In the Save As window, navigate to the D:\PowerBI\Lab06 folder, and then click Save. 

8. In the left pane, select the third slide. 

9. On the Insert ribbon tab, from inside the Media group, click Video, and then select 

Video On My PC. 

 

Figure 27 

Locating the Video Command 

 

10. In the Insert Video window, navigate to the D:\PowerBI\Lab06 folder. 

11. Select the US Sales.mp4 file, and then click Insert. 

12. Resize the image file to fill the slide area. 

13. On the File menu, select Save. 
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14. To start the presentation, on the Slide Show ribbon tab, from inside the Start Slide 

Show group, click From Beginning. 

15. To navigate to the third slide, click the down arrow key twice. 

16. To start the video, hover the cursor over the presentation, and then click the Play button. 

 

Figure 28 

Locating the Play Button 

 

17. When the video has completed, click the down arrow key to proceed to the next slide. 

18. To exit the presentation, press Escape. 

 

Task 12 – Finishing Up 

In this task, you will finish up by closing Excel. 

1. To close PowerPoint, click the X button in the top right corner. 

2. To close the Power Map window, on the File ribbon tab, select Close. 

3. To save the workbook, on the File ribbon tab, click Save. 

4. To close Excel, click the X button in the top right corner. 

 

Summary 

In this lab, you produced a tour consisting of four scenes to spatially and temporally present 

revenue data for the Tailspin Toys US sales operations. You then embedded a video of the tour 

in a PowerPoint presentation. 


